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Creating an Accessible Canvas Site

With Long Beach City College (LBCC) taking precautionary measures and moving
instruction to online platforms, it has become pertinent to ensure that course content
provided via online instruction are accessible on an IT level. This includes documents,
videos, and websites. Ensuring accessibility will ensure all students can fully participate
in the course.

The following sections provide additional guidance for making online course materials
accessible.

CREATING DOCUMENTS

Some digital documents are more accessible than others. The most accessible document
format is HTML created using the rich text editor in Canvas.

Care must be taken to ensure web pages are accessible. For example, headings must be
tagged as headings at appropriate levels to form an outline of the document content, and
images must be briefly described for non-visual users by entering “alt text” in the
relevant form field when adding the image.

Canvas Features Use the Rich Content Editor
— Announcements
— Assignments
— Discussions
— Pages
— Quizzes

— Syllabus

View Rich Content Editor

The Rich Content Editor includes the content area and the content selector.

Anything that can be viewed in a web browser can be inserted into the Rich Content
Editor content area [labeled 1 below].

Content can also input HTML directly into Canvas using the HTML Editor link [labeled
2 below].

Users can also easily link to course content using the Content Selector [labeled 3 below],
which is displayed in the sidebar any time the Rich Content Editor is open. Depending on

PAGE 3



the feature area being viewed (course or group), users may be able to link to existing

files, images, or links, and upload new files and images.

e

Documents in Other Formats (Word, PDF, PowerPoint)

If you choose to distribute documents in another format such as Adobe PDF, Microsoft

Word or Microsoft PowerPoint, know that these formats support accessibility, but

documents are not accessible by default. Authors must take care to follow the guidelines
for creating accessible documents. Many of the issues are the same as for web pages
(e.g., use appropriate headings, add alt text to images) but the techniques vary across
document authoring tools.

Creating Accessible Documents in Microsoft Word

The text within Word documents can be read by assistive technologies such as screen

readers and Braille devices. However, in order for Word documents to be fully
accessible, authors must follow the core principles below:

Use Headings

Headings and subheadings should to be identified as such using the built-in heading
features of the authoring tool. Headings should form an outline of the page content
(Heading 1 for the main heading, Heading 2 for the first level of sub-headings, Heading 3
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for the next level of sub-headings, etc.). This enables screen reader users to understand
how the page is organized, and to quickly navigate to content of interest. Most screen
readers have features that enable users to jump quickly between headings with a single
key-stroke.
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Use Lists

Any content that is organized as a list should be created using the list controls. When lists
are explicitly created as lists, this helps screen readers to understand how the content is
organized. When screen reader users enter a list, their screen reader informs them that
they’re on a list and may also inform them of how many items are in the list, which can
be very helpful information when deciding whether to continue reading.
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Use Meaningful Hyperlinks

Links presented in an electronic document should convey clear and accurate information
about the destination. Most authoring tools allow the creator to assign a hyperlink to text.

For documents that will be circulated as print material, use a URL shortening service to
create a customized and meaningful link name.

Insert Hyperlink ? >
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Look in: | Documents vl |3 A
Existing File
or Web Fage Audit ” Bookmark...
(f:grrent AXIS Companion - Clips
older ) ; T tE
Camtasia Studio L e
e Custom Office Templates
Document Browsed

Pages Job Bulletin_files
ﬁ Meeting Motes
Midterm-Revised_ COUMN 3114-07_files

Create Mew Recent
Document Files Metwork Monitor 3
CULIOUR Fies v |
=] Address: | Actual Hyperlink ~
E-mail
Address

Cancel
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Add Alternate Text for Images

Users who are unable to see images depend on content authors to supplement their
images with alternate text, which is often abbreviated “alt text”. The purpose of alt text is
to communicate the content of an image to individuals who can’t view it.

If images are purely decorative and contain no informative content, they do not require a
description. However, they may still require specific markup so screen readers know to
skip them.

Format Picture X

SH O owE

I Text Box

4 Al Text
Title (&

Description

Bright blue glacial lake surrounded by
white ice on a dark mountain

Identify Document Language

Leading screen reader software is multilingual, and can read content in English, Spanish,
French, and a wide variety of other languages. In order to ensure that screen readers will
read a document using the appropriate language profile, the language of the document
must be identified.

You should also identify the language of any content written in a language other than the
document’s default language. With this information, supporting screen readers will
switch between language profiles as needed on the fly.
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Creating Accessible PDFs Using Word and Adobe Acrobat Pro

The first step in creating an accessible PDF from Microsoft Word is to ensure that the
original Word document is accessible.

Starting with an accessible Word document, a goal when exporting to PDF is do so in a
way that preserves the accessibility features of the Word document, including heading
structure, alternate text for images, and markup that explicitly identifies lists, tables,
document language, and other content that is important for accessibility.
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Do not print to PDF. This method of creating a PDF does not preserve the document’s
accessibility features. The correct method of exporting to PDF depends on which version
of Microsoft Office you’re using.

Word 2010, 2013, and 2016 (Windows)
Go to File > “Save As...” and select PDF from the choices provided. By default this

produces a PDF that preserves the document’s accessibility features.

When saving, select Options and be sure that “Document structure tags for accessibility”
is checked. This is checked by default, but could become unchecked under certain
circumstances.

Lar teetvva e : M mmm mae - -~ - aa omm - e PR . DR e oaem
File name: | Doch.pdf v
Save as type: | PDF (*.pdf) ~
Authors:  Bernadette Gonzalez Tags: Addatag Title: Add a title
Optimize for: (@) Standard (publishing Options...

online and printing)

O Minimum size || Open file after publishing

(publishing onling)

~ Hide Folders Tools = Cancel

Options ? X

Page range
O
O Current page
Selection
() Page(s) From: |4 <] Tor [4 =
Publish what
(®) Document
Document showing markup
Include non-printing information
Create bookmarks using:
Headings
Word bookmarks
A Document oronerties
Document structure tags for accessibility
PDF options
[1150 19005-1 compliant (PDF/4)
Bitmap text when fonts may not be embedded
D Encrypt the document with a password

o0 ][ omee

Word 2016 (Mac)

In Office 2016, Word can now generate a tagged PDF that preserves a document’s
accessibility features. To use this feature:

Go to File > “Save As...” and select PDF from the choices provided. By default this
produces a PDF that preserves the document’s accessibility features.

When saving, be sure the box labeled “Best for electronic distribution and accessibility”
is checked.
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Fixing Inaccessible PDFs Using Adobe Acrobat Pro DC

It is always best if possible to start with an accessible source document (e.g., in Microsoft
Word) and export to an accessible PDF. This way, if the document is edited later, the
document’s accessibility features will still be intact and when the document is exported
again to PDF the accessibility features will again be passed to the PDF.

However, if the original source document is not available, accessibility features can be
added to the PDF using Adobe Acrobat Pro DC.

For steps on this process please visit the following link: Fixing PDF Accessibility

Creating Accessible Presentations in Microsoft PowerPoint

Microsoft PowerPoint is commonly used to create slide show presentations to convey
information in a visual format that can include a combination of text, tables, images,
charts, and graphics. For users of assistive technology, screen readers and Braille devices
can convey content in a PowerPoint presentation if the author follows the core principles
outlined above. The following information includes basic steps for applying these core
accessibility principles and for keeping accessibility in mind.

Use Built-in Slide Templates
Built-in slide layout templates are designed so the reading order is compatible with
assistive technology such as screen readers.

File Slide Master Home Insert Draw Transitions Animations Review View Help © Tell me

% ﬁt‘] | Title E & ]

Insert Slide Insert [_:‘J Insert Themes Background Slide Close
V| Footers 2 e
Master Layout Placeholder - E Size - Master View

Edit Master Master Layout Edit Theme Size Close N

- -

Click t

Click to edit Master title styl

Click to edit Master title style

Click to edit Master subtitle style

“Mn <

Slide Master [ 1/ = -—f§ + 38%

Avoid using Text Boxes as they do not show up in Outline View which makes
converting PowerPoint to HTML problematic. If there are more than one Text Box
on a slide it may be read out of order by a screen reader. Use a pre-set layout from
the New Slide drop-down selection options, select the layout that best fits your needs.
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Use Unique Slide Titles

Individuals who use a screen reader skim slide titles to navigate, they can quickly scan
through a list of slide titles and go right to the slide they want. Using unique slide titles
allows them to clearly understand which slide they are on. Avoid using the same title for
slides that have spill-over information, consider including additional information such as
‘Slide Title 1 of 2°.

Make Hyperlinks and Tables Accessible

Screen reader users sometimes scan a list of links. Links should provide a clear and
accurate description of the link destination. Rather than providing the URL of the link,
consider creating a hyperlink with text to describe it.

Browsed | @ PowerPoint-slide-master.png

_ﬂ Pages |@" PPT_Template_Std-Solid-ADA.pptx
E-thiil Adkdiress l: Presentatuom.‘p');')tx
& Word-accessibility-checker.png
Recent Files | & Word-bullets.png

| Word-headings.png

Address: http://www.washington.edu/accessibility/| v

X

Insert Hyperlink ?
Link to: Text to display: UW Accessible Technology ScreenTip...

Existing File ... | ook in: Acc Tech website v |% q
¢ @° ~$Presentation1.pptx A Bookmark...

Place in Thi... Current | ~¢syllabus_accessible.docx
e Foidt @ 1_syllabus.docx
& @ 2_syllabus_accessible.docx

Create Ne...

To keep track of their location in a table, screen readers count table cells and use header
information to identify rows and columns. If a table is overly complex, the screen reader
loses count and can’t provide useful information about the table. Blank cells in a table
could also mislead someone using a screen reader into thinking that there is nothing more
in the table.

Set Reading Order of Slide Contents

Screen readers read the elements of a slide in the order they were added to the slide,
which might be very different from the order in which things appear. To make sure
everyone reads the contents in the order you intend, it’s important to check the reading
order by using the Selection Pane. From here, you can drag and drop to adjust the reading
order of the contents on the slide.
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NOTE: The reading order in the Selection Pane should be arranged from the bottom up.
The title should be at the very bottom with subsequent content following it.
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A X =+ 0 Layout v [ (m] \
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—— Text Placeholder 6 ©
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Content Placeholder 2
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App ges 3 . Text Placeholder 5 L0
* Apples are red * Feline vs canine Title 1 o
* Oranges are orange * Carnivore vs scavenger
* Apples are dense * Nocturnal vs diurnal
* Oranges have ‘juice cells’ * Aloof vs social
* Nothing rhyicies with orange * Sprinters vs distance runners
Sfide20f 2  English (United States) = Notes ¥ Comments H- = A + 70% B3

Add Alt Text to Visuals, and Tables

For screen reader users, alternative text helps to communicate what is important in
images and other visuals. Alt text provides a textual alternative to non-text content.

Use the Accessibility Checker

Microsoft products have a built-in accessibility checker which can help the document
author test the overall accessibility of the document. The checker provides Inspection
Results, feedback about the importance of each item, and tips on how to repair issues.

Accessibility Checker - x

Inspection Results
Errors

4 Missing alternative text
Picture 4 (Slide 2)
Picture 6 (Slide 2)

Warnings
4 Check reading order
Slide 2 v
Additional Information v
Why Fix? N

People who cannot view the slide will hear slide
text, shapes, and content read back in a specific
order. You should verify that the reading order
and labels will make sense in the order they will
be read back.

Steps To Fix:
To check the reading order of content:
1. Switch to the Home tab, click Arrange, and ¥

Read more about making documents
accessible
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Export to PDF

If all of the steps were followed to create an accessible PowerPoint presentation,
exporting to PDF properly will ensure heading structure and other accessibility
information will remain intact.

Users of PowerPoint for Mac should be cautioned that exporting to PDF will not yield an
accessible, tagged PDF document, it must be remediated using Acrobat Pro.

CREATING ACCESSIBLE VIDEOS

Videos should be produced and delivered in ways that ensure that all members of the
audience can access their content. An accessible video includes captions, a transcript, and
audio description and is delivered in an accessible media player.

Captions

Captions are text versions of the audio content, synchronized with the video. Captions are
mandated by law and essential for ensuring your video is accessible to all students.

There are two general approaches to captioning video:
Do it yourself.

There are free tools available online that make it possible and easy to caption your own
video. The following are platforms that provide some type of free captioning:

— Camtasia: LBCC currently has a campus wide license
— Amara.org
— Dotsub.com
— Subtitle-horse.com
Outsource.

— If you use Canvas:

=

Submit video through 3CMedia upload space in Canvas
2. Captioning will automatically be added to your media. Closed captioning will be
completed in approximately 3-5 business days. In canvas

— If you do NOT use Canvas

1. Check with your department for approval to submit a captioning request form. Please
get departmental approval before submitting.
2. Submit a Captioning Request Form at https://Ibcc.instructure.com/courses/26987
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3. After submitting the Caption Request Form, based on the information provided, your
request is either routed to DSP&S or the Online Learning Depaltment for review &
follow-up.

4. Either DSP&S or the Online Learning Department will send the video to a vendor for
captioning, and will return the captioned video along with an invoice of cost to you
and your department.

YouTube and Captions

Please be aware that YouTube captions are not always accurate and should not be
considered reliable. YouTube utilizes voice recognition and as a result, the captions are
often inaccurate and do not possess the proper punctuation necessary for full student
access.

Providing Students with Extra Time on Exams

ON CANVAS

Once you have published a quiz, the quiz sidebar shows the Moderate Quiz link, which
allows you to moderate the quiz for each student in your course. On the Moderate Quiz
page you can view the progress of student submissions and view the number of quiz
attempts each has taken. You can also grant students extra attempts, grant extra time for
timed quizzes, and manually unlock quiz attempts.

Open Quizzes
Pages
Files

Outcomes

[ Quizzes

Conferences

Collaborations

In Course Navigation, click the Quizzes link.
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+ Assignment Quizzes

7 The Articles of Confederation and the Constitution Quiz
v Available Multiple Dates | Due Multiple Dates | 10 pts | 10 Questions

) lHistory Ovenriewl
- ot available until Fe | Due Feb 15 at 1:5%pm | 11pts | 11 Questions

The Bill of Rights Quiz
Due Feb 21 at 3pm | 10pts | 10 Questions

Click the name of the quiz.

Moderate This Quiz

@ Published Preview % Edit

History Overview

Quiz Type Graded Quiz
Points 11

Assignment Group Quizzes

Related Items

&0 Quiz Statistics

[@ Moderate This Quiz

 Download All Files

Vi SpeedGrader™

Click the Moderate This Quiz link.

View Search Filter

Moderate Quiz

Filter

To view the quiz attempts of a specific student, use the Search People field.
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View Moderate Quiz Columns

Moderate Quiz

Filter
o [ 2] o (4] o o
Stl:aént Angr;pt TiH\F:a Anemp.g Left Sggre E—i
Boone, Emily 1 finished in 7 minutes 9 8
Doe, Jessic: 1 finished in 1 minute 9 7.0
Johnson, Max 1 finished in 4 minutes 9 3.66666666666667 W
Jones, Bruce - 10

The Moderate Quiz page displays the following information:
— Student name [1]
— Number of times the student has already attempted to take this quiz [2]

— Quiz time—completed attempts show the time it took for the student to complete
the quiz; running time shows the remaining time the student has to complete the
quiz [3]

— Number of remaining attempts, if any [4]

— Quiz score—for multiple submissions, the score is the most recent attempt [5]
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